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These release notes contain system requirements for NI Circuit Design Suite 12.0, and 
information about product tiers, new features, documentation resources, and other changes since 
NI Multisim 11.0.2 and NI Ultiboard 11.0.2. 

NI Circuit Design Suite includes the NI Multisim and NI Ultiboard software products from the 
National Instruments Electronics Workbench Group. 
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Installing NI Circuit Design Suite 12.0 
This section describes the system requirements and installation procedures for NI Circuit Design 
Suite. 

Minimum System Requirements 
To run NI Circuit Design Suite 12.0, your OS must be one of: 

• Windows XP 32-bit edition. 

• Windows Vista 32-bit or 64-bit edition. 

• Windows 7 32-bit or 64-bit edition. 

• Windows Server 2003 R2 (32-bit) or 2008 R2 (64-bit) edition. 

Note Circuit Design Suite 12.0 does not support Windows NT/Me/98/95/2000, 
Windows XP x64, or the Windows Server non-R2 editions. 

Your system must also meet or exceed the following: 

• Pentium 4 class microprocessor or equivalent (Pentium III class minimum). 

• 512 MB of memory (256 MB minimum). 

• 1.5 GB of free hard disk space (1 GB minimum). 

• Open GL® capable 3D graphics card recommended (SVGA resolution video adapter with 
800 × 600 video resolution minimum, 1024 × 768 or higher preferred). 

• To develop custom LabVIEW-based instruments for use in Multisim, LabVIEW 2010 or 
2011 is required. 

Installation Instructions 
The NI Circuit Design Suite 12.0 installer installs both products in the suite: NI Multisim and 
NI Ultiboard. 

National Instruments recommends that you close all open applications before you install 
NI Circuit Design Suite. 

By default, the NI Circuit Design Suite installation program copies files to <Program Files>\
National Instruments\Circuit Design Suite 12.0 after you complete the 
following steps: 

1. Insert the NI Circuit Design Suite CD into the CD-ROM drive. If the CD startup screen does 
not appear, select Run from the Windows Start menu and run setup.exe from your CD 
drive. 
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2. Follow the instructions in the dialog boxes. 

Note To install the NI Multisim LabVIEW Co-Simulation Plug-in, you must 
already have NI LabVIEW 2011 (32-bit) and NI LabVIEW Control Design and 
Simulation Module 2011 installed on the machine. You can install the Co-Simulation 
Plug-in at a later time by first installing LabVIEW 2011 and the Control Design and 
Simulation Module 2011 and then re-running the Circuit Design Suite 12.0 installer. 

Product Activation 
When you run a product in NI Circuit Design Suite for the first time, it will prompt you to 
activate the product. 

If you do not have a valid license, the product will run in Evaluation Mode and continue to 
prompt you to activate on each subsequent run. Evaluation Mode is valid for 30 days following 
the first run of the product. 

For information about how to activate your software product, please refer to the Activation 
Instructions for National Instruments Software Note to Users included with your NI Circuit 
Design Suite package. 

What’s New in NI Circuit Design Suite 12.0 
This document describes the following feature additions or improvements to NI Circuit Design 
Suite 12.0: 

• LabVIEW-Multisim co-simulation. 

• Multisim snippets. 

• Upgrades to Microchip software. 

• Database improvements. 

• Improvements to interface and property editing for generic diodes, transistors and FETs. 

• Digital signal analysis. 

• Improved text handling in Multisim. 

• Ability to load last file on Multisim startup. 

• Buses and connectors added to sheet properties color scheme. 

• Ability to configure pin and gate swapping added to Multisim. 

• Display of net/component attributes in status bar. 

• Thumbnails. 

• Improvements to DXF import. 

• Improvements to Parts Position tab. 

• Improved shortcut for toggling layers. 

• Layers tab is default on Ultiboard startup. 

• Force vectors off on Ultiboard startup. 

• Improvements to polygon functionality in Ultiboard. 

• Connectivity check and warn on single pins. 
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• Amalgamation of component help into Multisim Help. 

• Bug Fixes. 

LabVIEW-Multisim Co-simulation
Multisim includes detailed simulation models which can now be used to simulate electrical 
components directly in LabVIEW using the new Multisim Design VI. 

In LabVIEW 2011, the Multisim Design VI represents a Multisim design file that you want to 
simulate. When you place the Multisim Design VI in a Control & Simulation Loop, Multisim 
and LabVIEW co-simulate in a highly integrated manner. 

The NI Multisim LabVIEW Co-Simulation Plug-in includes the Multisim Design VI. It installs 
automatically when you run the NI Circuit Design Suite installer. 

Note For the NI Multisim LabVIEW Co-Simulation Plug-in to successfully install, 
you must already have NI LabVIEW 2011 (32-bit) and the NI LabVIEW Control 
Design and Simulation Module 2011 installed on the machine. 

Multisim Snippets
You can now save snippets of a Multisim design to reuse later or to share with other Multisim 
users in a .png image file. The image file shows a picture of your design and contains design 
information for all components in the snippet, including symbol, model, footprint and connected 
nets. 

Upgrades to Microchip Software 
The HI-TECH PICC compiler that is included with Multisim has been upgraded to version 9.82. 

The Microchip MPASMWIN assembler is upgraded to version 5.42. 

Database Improvements 
Refer to http://zone.ni.com/devzone/cda/tut/p/id/5607 for more detailed 
information about the components and models included in your edition of Multisim. 

Manufacturers’ component updates: 

• Over 225 new and updated Analog Devices and National Semiconductor components. 

• Over 1,800 new and updated NXP and Philips components. 

• Over 90 new National Instruments connectors, including NI sbRIO connectors, NI DAQ 
connectors for E Series, S Series and X Series devices. 

• Over 75 new industry standard connectors, including USB connectors, DSUB connectors 
and banana jacks. 

http://zone.ni.com/devzone/cda/tut/p/id/5607/express.nsf/bycode/mltsim11


© National Instruments Corporation 5 NI Circuit Design Suite Release Notes

As well as the above manufacturers’ components, the database includes the following new devices:

• 25 parameterizable transformer components.

• 13 parameterizable machine components, including DC machines, induction machines, 
brushless DC machines and stepper motors, as well as a number of supporting components 
such as stepper motor drives, mechanical loads and speed sensors. 

• Several simplified power semiconductor switches including transistors and thyristors for 
high-level simulation.

• Several new voltage-controlled generic switches including single pole double throw and 
single pole single throw. 

• A single pole single throw switch with a customizable bounce pattern. 

• Control signal to PWM generators.

• Phase angle controllers.

• Step and chirp signal voltage and current sources.

• Interactive DC voltage and current sources. 

Obsolescence Information 
To help guide designs, components in the Multisim database now contain information about 
component availability from some manufacturers. 

The Select a Component browser now displays a link when a component has been marked 
obsolete by a manufacturer. Click Obsolescence information to display the Component 
Obsolescence dialog box. 

While one manufacturer may have discontinued a component, a replacement may exist, or the 
component may still be available from another manufacturer. Some obsolete components will 
have manufacturer suggested replacements listed. 

Note Consult the manufacturer's website for the most accurate and up-to-date 
information about component availability and replacements. 

Component Filter
A filter has been added to the Select a Component dialog box that allows you to select whether 
or not to list components without models in the dialog box. 

Improvements to Interface and Property Editing for Generic 
Diodes, Transistors and FETs
You can more easily access and modify the parameters of the discrete components so that the 
generic device can better match the operating conditions required in the design. All instance and 
model parameters  are now easy to access. 

You can also select the device model type for a given component. 
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Digital Signal Analysis
There is a new digital graph type in Multisim's grapher. 

It can be used from various analyses and is able to display both native digital signals and analog 
signals that have been digitized using configurable digitization thresholds. 

Improved Text Handling in Multisim
Now, when you place text in Multisim, a Text toolbar appears where you can select the font, text 
size, stroke weight and style, and adjust the text color and alignment. 

You can also rotate and flip any text on the workspace, including a component’s RefDes and 
description. 

Alignment of objects, including text is available from the Edit»Align menu. 

Ability to Load Last File on Multisim Startup
You can set Multisim to load the last file on startup from the General tab of the Global 
Preferences dialog box. 

Buses and Connectors Added to Sheet Properties Color 
Scheme
You can adjust the color of buses and connectors from the Colors tab of the Sheet Properties 
dialog box. 

Note the default color of buses and connectors has been changed from black to red for Multisim 12. 

Ability to Configure Pin and Gate Swapping Added to Multisim
Pin and gate swapping configuration has been added to the PCB tab of Multisim’s Sheet 
Properties dialog box. 

Display of Net/Component Attributes in Status Bar
When you select an element in Multisim 12, such as a component, net, bus or placed text, its 
attributes display in the status bar at the bottom of the screen. 

Thumbnails
Multisim and Ultiboard now provide a number of ways to see thumbnail-sized previews of files, 
designs and windows. 

A button in the Design Toolbox displays thumbnails of recently opened files that you can click 
to quickly open these files. 

Another button, on the bottom-right of the workspace, displays thumbnails of all currently open 
files. 
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Thumbnails also appear when you hover the cursor over open designs in the Hierarchy tab of 
the Design Toolbox. 

Multisim enhances this feature further to show the previews of the hierarchical blocks, 
subcircuits and parent designs. 

You can also display thumbnails from off-page connectors, bus off-page connectors, HB/SC 
connectors, and bus HB/SC connectors. Hover the cursor over the desired connector and click 
on the magnifying glass icon that displays. A thumbnail of the connected design appears. Click 
the thumbnail to go to the complementary connector on the connected page. 

Improvements to DXF Import
Ultiboard’s DXF Import Settings dialog box has had a number of improvements made to it, and 
has been renamed to DXF Import. 

Use this dialog box to import any of the following into Ultiboard: 

• Board outlines which originate from a mechanical design. 

• Other mechanical information. 

• Graphics such as a company logo. 

• Trace and polygon information. 

The DXF Import dialog box contains the following sections: 

• Layer mapping—Use to assign a layer from the DXF file to a specific layer in Ultiboard. 

• Scaling—The controls in this section determine how physical data in the DXF file is 
interpreted on import. 

• Other options—Contains infrequently used import options. 

Improvements to Parts Position Tab 
The read-only columns in the Parts position tab in the Ultiboard Spreadsheet View are now 
editable. 

Improved Shortcut for Toggling Layers in Ultiboard
Press <F2> to toggle between mirror layers. For example, if the active layer is Copper Top and 
you press <F2>, the active layer becomes Copper Bottom. Press <F2> again to make Copper 
Top the active layer. 

Press <Q> to return to the previous active layer. For example, if the active layer is Silkscreen 
Top and you switch to Board Outline, you can press <Q> to return to Silkscreen Top. 

Layers Tab is Default on Ultiboard Startup
The Layers tab of the Design Toolbox now displays on Ultiboard startup. 
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Force Vectors Off on Ultiboard Startup
Force vectors are now switched off by default on Ultiboard startup. 

Improvements to Polygon Functionality in Ultiboard
All filled copper shapes in Ultiboard are now copper areas, and include a Copper areas tab in 
their properties dialog box, where you can switch voiding off/on. 

Note A void is an empty area around traces, copper areas, pins and other objects that 
prevents unintentional connection to copper areas. 

The following commands have been removed:

• Place»Copper area—There is no longer any need to place unique copper areas, as all filled 
copper shapes are now treated as areas. 

• Design»Shape to area—There is no longer any need to convert a shape to an area, as all 
filled copper shapes are now treated as areas. 

• Place»Shape—All selections from this have been incorporated into Place»Graphics to be 
consistent with Multisim. 

Previous versions could only draw voids in 45o increments. Ultiboard 12 uses smooth voiding 
without any loss of performance. 

If you open an Ultiboard file that was created in an earlier version that includes voiding, a 
message appears in the Results tab of the Spreadsheet View advising you that the design uses 
45o voids. The message includes a link to the new Upgrade tab of the PCB Properties dialog box, 
where you can convert the design to use smooth voids. 

Note If you choose to update the design, the Upgrade tab will no longer appear for 
this design. 

Connectivity Check and Warn on Single Pins 
The ability to check for single-pin nets, that is, a net with only one pin attached to it, has been 
added to Ultiboard 12. 

A single-pin error can occur: 

• In error—for example, you create a net and do not name it to match an existing net. 

In this case, a connection error for the single-pin net is desired. 

• Intentionally—for example, you want to create a testpoint without a footprint, and instead 
modify the silkscreen on the top layer to expose the net. Or, if you design an on-the-board 
antenna, which would also be a single-pin net. 

In these cases, you would not want connection errors to display, so you would set the nets 
to be excluded from single-pin checking. 
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Amalgamation of Component Help into Multisim Help
Component Reference Help has been discontinued and its contents have been incorporated into 
Multisim Help. 

Bug Fixes 
Refer to the Readme file for a list of issues fixed in version 12.0. 

All readme files are located at <Program Files>\National Instruments\Circuit 
Design Suite 12.0\documentation. 

Product Tier Details 
The following lists the schematic capture functionality available in Multisim Base, Full, and 
Power Pro editions: 

Functionality Base Full Power Pro

Customizable GUI X X X

Modeless part placement and wiring X X X

Autowire when parts when brought together X X X

Autowire when part pin placed on a wire X X X

Fast retrieval parts bins X X X

User defined fields X X X

Component editing X X X

Advanced symbol editor X X X

Auto and manual wiring X X X

Virtual wiring by node name X X X

Fast auto-connect passives X X X

Rubber banding on part move X X X

Replace multiple components at once X X X

Buses X X X

Bus Vector connect X X X

Circuit restrictions X X X

Project manager X X X

Project packing X X X

Hierarchical design X X X



NI Circuit Design Suite Release Notes 10 ni.com

The following lists the simulation functionality available in Multisim Base, Full, and Power Pro 
editions: 

Multisheet design X X X

Circuit annotations X X X

Comments on schematic X X X

Electrical rules check X X X

Title block editor X X X

Forward/Back annotation X X X

Export to Mentor PADS layout X X X

Advanced component search X X X

Variant support X

Snippets – creating X

Snippets – opening X X X

Spreadsheet view X

Design constraints X

Zoom to selected part X

Pin and gate swap X

Customizable BOM X

Advanced reports X

Cross-probing with Ultiboard X

ERC scope setting X

Mark no-connect pins X

Database import/export X

Component database Partial Partial Complete

Functionality Base Full Power Pro

Interactive simulator X X X

Fully mixed-mode A/D simulation X X X

Standard SPICE 3F5/XSPICE X X X

Enhanced model support X X X

Functionality Base Full Power Pro
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Cadence® PSpice® model simulation* X X X

Speed/Accuracy tradeoffs X X X

Convergence Assistant X X X

Virtual, interactive, animated parts X X X

Mouse click support for interactive parts X X X

Measurement Probes X X X

Component Wizard X X X

NI measurement data file sources X X X

NI measurement data file export X X X

NI LabVIEW VIs as instruments and sources X X

LabVIEW-Multisim Co-simulation X X

Simulation Profiles X X

Grapher X X X

Grapher – Digital Display X X

Postprocessor X X

Expressions in analyses X X

Add traces to Grapher post analyses X X

Rated components X X

Insert faults into components X X

Op-Amp Wizard X

555 Timer Wizard X

Filter Wizard X

CE Amplifier Wizard X

Model makers X

Switch mode power supply generics X

RF Design Module X

Nested sweeps X

C-Code modeling X

Virtual Instruments 4 15 22

Functionality Base Full Power Pro
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The following lists the layout functionality available in Ultiboard Full and Power Pro editions:

Analyses 0 16 20

Simulated Agilent instruments 0 1 3

Simulated Tektronix instrument 0 0 1

Multisim MCU X X

Multisim Automation API X

* Does not support all Cadence® PSpice® syntax

Functionality Full Power Pro

Gridless Follow-me placement X X

Push and Shove part placement X X

Push and Shove trace placement X X

Auto-alignment X X

Real-time polygon update with voiding X X

Keep-in/Keep-out areas X X

Forward/Backward annotation X X

Real-time DRC X X

Jump to Error X X

64 layers and 1 nanometer resolution X X

Polar Grids X X

Customizable layer viewing X X

Split power-planes X X

Comprehensive Footprint Wizard X X

Enhanced 3D visualization with print X X

Full screen mode X X

Gerber, DXF, IPC-D-356A, SVG output X X

Dimensions on PCB and Landpatterns X X

Dimensions in Database Manager X X

User annotations X X

Net bridges X X

Functionality Base Full Power Pro
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3D visualization inside circuit board X

Turn off ratsnest for selected nets X

Load and save technology files X

Cross-probing with Multisim X

Variant Support X

Component Placement Sequencer X

Place components in array X

Unplace all components X

Ruler bar alignments and measurements X

Save PCB Design as a component X

Permanent grouping X

Pin & gate swapping X

Gridless Connection Machine X

High-speed constraint driven layout X

Multiple clearances X

Net topology choices X

Equispace trace support X

Differential Impedance Calculator X

Transmission Line Calculator X

Microvias X

Test point insertion X

Automatic tear-dropping X

Pin necked trace support X

Automatic jumper insertion X

Copy Route & Replica Place functions X

In-place footprint editor X

Mechanical CAD X

Export 3D info in 3D IGES, DXF formats X

Copper amount report X

Functionality Full Power Pro
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The following lists the autorouting functionality available in Ultiboard Full and Power Pro editions:

Test point report X

Number of pins supported 2,000 Unlimited

Spreadsheet view Limited Complete

Functionality Full Power Pro

Autoplacement X X

Pin & gate swapping X X

Fully customizable cost factors X X

Progressive Routing X X

Interactive autorouting X X

Constraint driven routing X X

Follows keep-in/keep-out criteria X X

Manual pre-placement: components, vias, traces X X

Auto Block Capacitor recognition X X

SMD mirroring X X

Net shielding X X

Automatic testpoint insertion X X

Trace rubberbanding X X

Topology: shortest, daisy chain, star X

Prioritize routing order X

Route an individual net X

Automatic bus routing X

Differential Pair routing X

Group autoplace X

Group autoroute X

Optimization X

Pin number limit 2,000 Unlimited

Maximum number of layers 4 64

Functionality Full Power Pro
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Localization 
NI Circuit Design Suite 12.0 is localized for English, German, and Japanese. The system locale 
setting determines the default language used by the software. 

To change the language the software uses, select Options»Global Preferences, click on the 
General tab, select the desired language from the Language drop-down list, and restart the 
application. 

The following items are not localized, and remain in English: 

• LabVIEW instruments.

• Layer names in both NI Ultiboard and the NI Multisim Spreadsheet View.

• Agilent and Tektronix simulated instruments. 

• Sample files. 

• MCU functionality: source file names, code/comments within source files, and 
compiler/linker messages. 

The following documentation is available in English, German, and Japanese: 

• NI Circuit Design Suite Release Notes. 

• Getting Started with NI Circuit Design Suite. 

User manuals and help files are not localized, and remain in English. 

Documentation 
NI Circuit Design Suite 12.0 includes a complete documentation set featuring printed and 
electronic resources for your reference. 

The following printed and electronic resource is available: 

• NI Circuit Design Suite Release Notes. 

The following are available from the installed software Help menu and from the Start menu: 

• Getting Started with NI Circuit Design Suite. 

• NI Multisim Fundamentals. 

• NI Ultiboard Fundamentals. 

• Multisim Help. 

• Ultiboard Help. 

To access the above, choose the desired link from the Help menu, or select select Start»
All Programs»National Instruments»Circuit Design Suite 12.0»Documentation and then 
select the file of interest. 

The following online help files are available from the installed software Help menu: 

• Multisim Symbol Editor Help (access from the Symbol Editor).

• Multisim Title Block Editor Help (access from the Title Block Editor).
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